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System requirements and compatibility

This section provides the following information for this release of IBM® Contact
Optimization:
v Where to find system requirement and compatibility information
v Changes in support for third-party software

Contact Optimization operates as part of the IBM EMM suite of products.

Contact Optimization version 9.1.0 requires Campaign 9.1.0.

You can upgrade to Contact Optimization 9.1.0 from Contact Optimization version
8.5 or later. For instructions, see the IBM Contact Optimization Installation Guide.

Contact Optimization supports 64-bit operating systems only for production
installations.

Where to find complete system requirement and compatibility
information

For a list of IBM EMM product versions compatible with this product and a list of
third-party requirements for this product, see the Recommended Software
Environments and Minimum System Requirements document. This document is posted
under Detailed System Requirements on the IBM Support Portal website:
(http://support.ibm.com).

Note: To access the IBM EMM documentation from the Support Portal, you must
log in with an IBM account. This account must be linked to your IBM customer
number. To learn more about associating your account with your IBM customer
number, see Support Resources > Entitled Software Support on the Support
Portal.

You can also access this document by selecting Help > Product documentation
when you are logged in to IBM EMM.

New features and changes in version 9.1.0
The following new features and changes are introduced in version 9.1.0 of IBM
Contact Optimization.

Agent Capacity Optimization

With the 9.1 release, Contact Optimization users can now also use Optimization
over a branch or Agent channel. You use Agent Capacity Optimization to route
high value offers through agents to high value consumers. By routing certain offers
for select consumers through your agents, you assure one on one contact with high
value consumers and increase the return on your marketing investment. To use
Agent Capacity Optimization, while you create a Contact Optimization session,
you must declare a campaign channel that is considered as an Agent channel. All
offers that are proposed through this channel are routed through agents. You
specify one Agent Information table and one Agent Customer Relationship table
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for your session. Then, you define a Cross Customer Min/Max # Offers Capacity
rule on the Agent channel.

UpdateSessionTableStatistics

The UpdateSessionTableStatistics parameter adds a query for updating statistics of
the PCT, RC, and POA tables during an Optimize Session run. You can tune this
parameter at the session level without affecting other sessions. Keeping up-to-date
index statistics can help improve the performance of the query on these tables.
This parameter is also present in the global configuration settings of Optimize.

FICO replacement with iLog

Contact Optimization now uses IBM CPLEX Solver to execute the mathematical
calculations necessary to choose the best offer for each campaign target, replacing a
non-IBM technology. Using IBM's own technology for optimization gives IBM the
opportunity to ensure that roadmaps are well aligned and the product teams
collaborate closely in the future, ensuring the Contact Optimization product always
achieves top performance.

Enable Max Capacity Consumption

If you get Contact Optimization results that underutilized the Channel capacities,
enable EnableMaxCapacityConsumption to reduce the loss of Channel Capacity.
Then, rerun the Contact Optimization session. If the parameter is set to
EnableMaxCapacityConsumption true, Contact Optimization uses an enhanced
algorithm for trying to meet maximum constraints that are set in Cross Customer
rules (Min/Max # Offers Capacity rule and Custom capacity rule). However, if this
is used, the session run time might increase depending on the data that is
provided to the session.

IBM EMM installation and upgrade improvements

The improvements to the installation and upgrade process include:
v Installation guides for all products have been rewritten and reorganized into

separate installation and upgrade guides, to make information easier to find and
use.

v The installers have been enhanced to include better descriptions of the
information you need to enter and to clarify what steps to take during each
stage of the installation.

v Each installer now provides links directly to the product's installation and
upgrade guides, in either PDF or HTML formats.

Change in documentation regarding target cell spreadsheets

In the Contact Optimization User's Guide, the topic "The target control spreadsheet
and pre-optimization flowcharts" should be "The target cell spreadsheet and
pre-optimization flowcharts."

Also, do not relate TCS control cells to the Optimize process box in a
pre-optimization flowchart. Declare control cells after optimization.
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Fixed defects
This section lists defects that are fixed in IBM Contact Optimization version 9.1.0.
The defects are sorted by defect number then by incident number (if applicable).

Issue ID Description

Defect 7620 Truncated issue in Report Run drop-down list of Analysis tab

Defect 7628 Error message font is too small to read

Defect 4488 Checkbox overlay some strings in the Rule tab of Contact Optimization Session

Defect 1692 After creating an Optimize session and saving it, if you edit the session and give it a blank
name, an error message is not displayed and the previous session name is not updated.

Defect 9140 ContactOptimization-ja: Truncation in the Report Type drop-down list

Defect 11540 Optimize server crash due to FEC Min/Max rule on AIX

Defect 5150 Contact Optimization session fails with TRYING TO REMOVE STALE PROPOSED RECORDS FROM
PCT error.

Known issues
This section lists known issues in Contact Optimization 9.1.0.

Issue Issue ID Description

ContactOptimization-zh_CN, KO:
Bad layout and alignment in the
fourth page

Defect 7637 ContactOptimization-zh_CN, KO: Bad layout and alignment
in the fourth page

After upgrading Campaign to 9.1,
Optimize listener can no longer be
stopped via ACOServer.sh.

Defect 81245 Users must upgrade Campaign and Contact Optimization
together. If they cannot, they will need to stop the Contact
Optimization listener manually through the task
manager/kill command.

Create Contact Optimization session
fails with multi-byte audience level
name.

DEF023178 If a non-English language with multiple-byte characters is
used to name an audience level, Contact Optimization fails
to create Contact Optimization sessions that contain that
audience level. To work around this issue, use English or
single-byte character sets to name your audience levels.

Error messages for the
ACOOptAdmin utility do not display
according to non-English locales.

DEF051284 When you run the ACOOptAdmin command-line utility in
a locale other than English, error messages do not display
according to the specified locale. The error messages display
only in English.
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Issue Issue ID Description

Contact Optimization listener does
not automatically use the same
non-English locale that is used by
Campaign listener.

ENH11618 In installations where Campaign and Contact Optimization
are installed with a non-English locale, the Contact
Optimization listener always starts in English instead of the
installed locale.

To work around this issue, in the command window or
batch file (ACOServer.bat or ACOServer.sh) used to start the
Contact Optimization listener, set LANG=xx_XX as follows.

v Brazilian Portuguese - pt_BR

v French - fr_FR

v German - de_DE

v Italian - it_IT

v Japanese - ja_JP

v Korean - ko_KR

v Simplified Chinese - zh_CN

v Spanish - es_ES

On UNIX systems, use the following commands.

LANG=xx_XX

export LANG

unprocessables_sessionid.csv might
contain some customers who receive
offers.

DEF054841 In some scenarios, a few of the customers who get offers
might be present in the unprocessables_sessionid.csv file.

Incorrect optimization result with
Custom Capacity rule in specific
circumstances.

DEF058362 A customer that satisfies the following criteria might receive
fewer offers than wanted:

v The customer has an even number of proposed
transactions.

v Each of these transactions has the same score.

v This score is a low value.

Some labels display incorrectly in
Japanese, Chinese, and Korean.

DEF059595 Some translated labels are displaying incorrectly. For
example, when you edit the score matrix manually, the
vertical label on the right side of the table displays upside
down. Also, for optimization rules that contain customers in
the segment, the segment label displays on two lines.

Offer filtering summary report
displays an incorrect count of
Proposed Contacts that are removed
by each Custom Capacity rule.

DEF059805 The Offer Summary Report displays incorrect counts in the
"Removed By This Rule" column for Custom Capacity rules
if the participating Flowchart for this Contact Optimization
session contains multiple contact dates and multiple offers
that are made to each customer on different channels.

Issues with offer version query
builder.

DEF060676 There are several minor issues with the offer version query
builder:

v For custom attributes with the Form Element Type of
Select Box, the offer version query builder does not use
the select box. You must enter the value manually.

v When the group level is removed, the subgroup
conditions are added to the parent condition, and vice
versa.

v All arithmetic operators are displayed for a string
variable, but only equal and not equal apply.

v Defined length validations for attributes are not verified
upon input for conditions.
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Issue Issue ID Description

Offer version rules that contain dates
do not provide expected optimization
results.

DEF061554 If you create an offer version condition that includes a date,
such as the offer parameter "valid end date" equals
"12/31/2011", the rule containing offer version condition
might not be satisfied; however, the rest of the rules will
work as expected.

Contact Optimization session run
fails with a Response XML is missing
the data xml element error.

DEF061116 If you receive this error, contact Technical Support. Also,
send your Contact Optimization server logs for analysis.

Rule exceptions that span calendar
years give incorrect results.

DEF061639 If you create a rule exception to a Min/Max # Offers
capacity rule that spans calendar years, such as 07/01/2011
to 06/30/2012, the rule containing rule exception condition
will not be satisfied; however, the rest of the rules will work
as expected.

Known limitations
This section lists known limitations in Contact Optimization 9.1.0.

Issue Number Description

Negative scores cause
inaccurate rules crediting.

DEF041400 If you use negative scores, rule crediting in the Offer
Filtering Summary report might not be accurate.

Offers with negative scores are given to meet minimum
requirements only.

Cells that are linked to TCS
with offer assignments do
not appear in Optimize
process.

DEF061355 If the Optimize process is connected to one or more cells
and the upstream cells are later linked to top-down cells
defined in the Target Cell Spreadsheet process (TCS), the
offers that are assigned in the TCS do not automatically
appear in the Optimize process. Link to any top-down cells
in the TCS before you connect those cells to an Optimize
process. Otherwise, you must either manually assign the
same offers within the Optimize process, or delete the
Optimize process and re-create it.

Running the ACOOptAdmin
utility with one-way SSL
requires more setup.

DEF046832 You cannot use the ACOOptAdmin utility with one-way SSL
until you register a security certificate, specify a host name
and domain, and configure SSL_Options in the
ACOOptAdmin.bat file.

Unable to run the session in
first attempt when
unica_acosvr process
stopped.

DEF055010 If you use the kill command to stop unica_acosvr, the
next time you attempt to run a Contact Optimization
session, it might fail with the following error An unknown
communication failure has occurred with the IBM
Optimize server process.

Workaround - Run the Contact Optimization session again
to complete it successfully.

New features and changes in version 9.0.0
The following new features and changes are introduced in version 9.0.0 of IBM
Contact Optimization.
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IBM Unica® Optimize renamed

IBM Unica Optimize is now known as IBM Contact Optimization.

The default installation directory is renamed to ContactOptimization.

Optimize sessions are now labeled Contact Optimization sessions.

ContinueOnGenerationLoopError

There is a new configuration property, ContinueOnGenerationLoopError. You can
use ContinueOnGenerationLoopError to continue a Contact Optimization session if
you receive the The generation loop was unable to eliminate all slack and
surplus variables error. See the IBM Contact Optimization Troubleshooting Guide for
more details.

Flowchart changes

The IBM Campaign flowchart workspace is redesigned to change the look and feel
and improve usability.

The framework is now based on a Dojo component instead of Active-X.

The redesign includes changes to the appearance of flowchart and report
components, including toolbars, dialog boxes, progress indicators, and related
controls. The overall functionality is unchanged. However, some minor
functionality is different. For details, see the IBM Campaign Release Notes and the
IBM Campaign User's Guide.

Russian language support

The Russian language is now supported. For information about setting locale
preferences, see the IBM Marketing Platform Administrator's Guide.

Browser behavior in IBM EMM products
IBM EMM products have certain browser restrictions and requirements.

Supported browsers

For a list of supported browsers, see the IBM Enterprise Marketing Management
Recommended Software Environments and Minimum System Requirements for version
9.1.0.

Pop-up blockers

You must disable any pop-up blockers in your browser or browser add-ons, such
as toolbars. Pop-up blockers prevent the flowchart window from opening.

Navigation methods

Do not use the browser controls to navigate. For example, avoid using the
browser's Back and Forward buttons. Instead, use the controls supplied in the IBM
EMM user interface.
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Using multiple browser windows in Internet Explorer

This restriction applies to using Internet Explorer (IE) with IBM Campaign or any
module that uses Campaign flowcharts (eMessage, Contact Optimization, Interact,
Distributed Marketing).

To log in multiple times to view side-by-side information, you must open IE and
log in to IBM EMM. Then select File > New Session in the IE menu bar. In the
new IE browser window, log in to IBM EMM as the same or a different user.

Important: Do not use any other method to open multiple sessions. For example,
do not open a new tab; do not open another browser session from the Start menu
or desktop icon; and do not use File > New Window in IE. These methods can
corrupt information that is shown in the application.

For details, see the IBM Campaign User's Guide.
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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